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For technical assistance outside the United States and Canada, contact your local technical support 

office.

Notice
No part of this publication may be reproduced or transmitted in any form or by any means, electronic 

or mechanical, including photocopy, recording, or any information storage or retrieval system, 

without permission in writing from Bio-Rad Laboratories, Inc.

Bio-Rad reserves the right to modify its products and services at any time. This guide is subject to 

change without notice. Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors 

or omissions, or for any damage resulting from the application or use of this information.
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Safety and Regulatory Compliance

Important Safety Information

Please read these instructions before attempting to operate the This instrument is 

suitable for research use only. It must be used, therefore, only by specialized 

personnel who know the health risks associated with the reagents that are normally 

used with this instrument. 

WARNING!  Use of the acrylic screen does not guarantee the user protection 

from UV radiation. The use of protective eyeglasses, mask, and/or gloves is 

strongly recommended.

Warranty

The   is warranted against defects in materials and workmanship for one year. If any 

defect occurs in the instrument during this warranty period, Bio-Rad Laboratories, 

Inc. will repair or replace the defective parts at its discretion without charge. The 

following defects, however, are specifically excluded:

 Defects caused by improper operation

 Repair or modification done by anyone other than Bio-Rad Laboratories, 

Inc. or the company’s authorized agent

 Use of spare parts supplied by anyone other than Bio-Rad Laboratories, 

Inc.

 Damage caused by accident or misuse

 Damage caused by disaster
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 Corrosion caused by improper solvents or samples

General Precautions

 Read the user guide carefully.

 The instrument must be used only for the intended purpose of gel 

documentation in research laboratories.

 The instrument must be connected to a grounded power source line and 

protected by a circuit breaker.

 Do not pour liquids directly on or inside the instrument.

 Switch off all lights on the instrument immediately after use.

 Clean the transilluminator sample area after use.

Regulatory Notices

The Gel Doc XR+ or ChemiDoc XRS+ imaging system is designed and certified to 

meet EN 61010, the internationally accepted electrical safety standard, EMC 

regulations, and TUV requirements. Certified products are safe to use when 

operated in accordance with this user guide. Do not modify or alter this instrument 

in any way. Modification or alteration of this instrument will

 Void the manufacturer’s warranty

 Void the regulatory certifications

 Create a potential safety hazard
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Alert Icons

Alert icons in this guide call attention to caution and warning paragraphs. Each icon 

indicates the type of hazard addressed.

Cautions

A caution in this guide alerts you to take or avoid a specific action that could result 

in loss of data or damage to the instrument. A caution can also indicate that, if the 

precaution against a potential hazard is not taken, minor or moderate injury might 

occur. 

Example

Caution:  With the exception of cleaning or replacing light bulbs, refer all 

servicing to qualified Bio-Rad personnel or their agents.

Table 1. How alert icons are used in this guide 

Icon Explanation

General

Indicates a potential hazard requiring special attention. This icon is used 

when the hazard or condition is of a general nature.

Electrical hazard

Indicates a potential hazard requiring special attention when you are working 

with electricity or electrical equipment.

Extreme heat and flammable materials

Indicates a potential hazard requiring special attention when you are working 

with extreme heat and flammable materials.

Radiation hazard

Indicates a potential hazard requiring special attention when you are working 

with UV radiation.
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Warnings

A warning in this guide precedes an action that, if not followed correctly, could 

cause serious injury or death to the operator, serious or total loss of data, or serious 

damage to the instrument.

Example

WARNING!  Use of the acrylic screen does not guarantee the user protection 

from UV radiation. The use of protective eyeglasses, mask, and/or gloves is 

strongly recommended.

Instrument Safety Warnings

Before you operate the instrument, carefully read the contents of Table 2.

Table 2. Safety cautions and warnings for the instrument

Icon Meaning

Caution: With the exception of cleaning or replacing light bulbs, refer all 

servicing to qualified Bio-Rad personnel or their agents. If you 

experience technical difficulties with the instrument, contact Bio-Rad to 

schedule service. The instrument should not be modified or altered in 

any way. Alteration voids the manufacturer’s warranty and might create 

a potential safety hazard for the user.

Caution: If the case interlock is defeated, there is a possibility of UV-B 

radiation hazard due to UV-B light exposure. Exercise caution when 

servicing the instrument. 

Caution: Disconnect the AC power cord before removing the 

instrument cover.

Warning: This instrument must be connected to an appropriate AC voltage 

outlet that is properly grounded.
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Notice

The Gel Doc XR+ or ChemiDoc XRS+ imager is intended for laboratory use only. 

This device is meant for use by specialized personnel who know the health risks 

associated with reagents normally used in electrophoresis. Bio-Rad Laboratories, 

Inc. is not responsible for any injury or damage caused by use of this instrument for 

purposes other than those for which it is intended, or for instrument modifications 

not performed by Bio-Rad Laboratories, Inc. or an authorized agent.

Power Safety Information

Voltage Setting Information

The universal hood for the Gel Doc XR+ or ChemiDoc XRS+ imager has a power 

supply that automatically chooses the correct voltage for your country or region.

Fuses

The universal hood for the Gel Doc XR+ or ChemiDoc XRS+ imager has two user-

serviceable fuses, F1 and F2, which are located on the bottom rear panel and are a 

part of the power entry module. See Fuse Replacement on page 48 for more 

information.
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1 Introduction

Gel Doc™ XR+ and ChemiDoc™ XRS+ gel imaging systems contain a charge 

coupled device camera (CCD) to capture images in real time. Image Lab™ software 

facilitates accurate positioning of the sample and generates optimized image data.

Each imager uses a lighttight enclosure (the universal hood) containing built-in UV 

and white light illumination. Both systems feature dynamic flat fielding technology 

for image uniformity and quantitation. Image Lab software controls image capture 

and optimization for the selected applications, analyzes results, and produces a 

report in a format you choose.

This instrument guide describes the Gel Doc XR+ and ChemDoc XRS+ imagers and 

includes general procedures for acquiring images. See the Image Lab Software 

User Guide for more detailed information about working with Image Lab software.

Gel Doc XR+ Imaging System

Gel Doc XR+ imaging system is a high-resolution gel documentation system for 

quantitation of gels and blots. Position the sample inside the imager and follow the 

onscreen steps to run a protocol with one click. You can create custom applications 

for a protocol or create a new protocol using many options in Image Lab software. 

Features include

 Detection of dynamic ranges that cover >3 orders of magnitude

 Dynamic flat fielding specific to fluorescent and colorimetric applications
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 Smart, application-based protocol setup using Image Lab software, which 

presents appropriate filter and illumination sources for each application 

 Ability to upgrade to the ChemiDoc XRS+ system

ChemiDoc XRS+ Imaging System

In addition to the gel applications you can use with the Gel Doc XR+ imaging 

system, the ChemiDoc XRS+ imaging system offers sensitive chemiluminescent 

detection. The imager includes a supersensitive CCD camera that is deeply cooled 

for the long imaging times required for faint sample detection and image data 

quantitation.

Features include

 Suitability for imaging applications that require excellent sensitivity 

(chemiluminescent western blots)

 Smart, application-based protocol setup using Image Lab software, which 

presents appropriate filter and illumination sources for each application 

 Dynamic range >4 orders of magnitude

 Flexibility to image chemiluminescent, fluorescent, and colorimetric 

samples with dynamic flat fielding specific to each application

System Components

CCD Camera and Lenses

The CCD camera, equipped with a motorized zoom lens (MZL), sits on top of a 

lighttight enclosure (the universal hood). After you perform initial calibration, a 

patented* algorithm controls the MZL to focus the lens automatically. Using Image 

Lab, you can control the MZL remotely to adjust zoom, focus, and iris.

*U.S. patent 8913127
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For camera specifications of each system, see the following:

 Gel Doc XR+ Technical Specifications on page 18

 ChemiDoc XRS+ Technical Specifications on page 22

Note: A factory installed +1 diopter lens makes the entire sample stage visible. 

This lens should always remain on the MZL assembly.

Universal Hood

The universal hood captures fluorescent and chemiluminescent images without 

using a photographic darkroom. The enclosure has built-in white light epi-

illumination and UV transillumination. For easy sample loading, the UV 

transilluminator is located in the universal hood drawer and can be accessed from 

the front of the imager. When not imaging, the lights in the darkroom enclosure turn 

off automatically.

The universal hood has touchpad buttons to perform various functions, but you do 

not have to control the lens and lights manually. Instead, you can use Image Lab 

software to control all functions remotely. Running a protocol overrides touchpad 

input.

Image Lab Software

Each system includes Image Lab software. In addition to controlling the imaging 

systems and acquiring and optimizing images, you can do the following in Image 

Lab:

 Annotate and document images

 Analyze molecular weights when imaging protein and nucleic acid gels

 Determine quantitation and purity of samples

You can print all or a subset of data in a report. You can also export data to other 

software, such as Microsoft Office®, for further analysis or presentation options. 

See the Image Lab Software User Guide for detailed instructions.
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Emission Filters

The universal hood can hold two different emission filters for fluorescent 

applications. No filter is required to image chemiluminescent samples. 

A standard filter (catalog #1708081) is used for colorimetric (white light) applications 

and is included in the installation kit. 

Optional Accessories

Bio-Rad Laboratories, Inc. offers a selection of optional filters and illumination 

sources. See Appendix C, Accessories, for ordering information and a complete 

listing of accessory filters, UV light sources, optional parts, and replacement parts.

Printer

For your convenience, Bio-Rad offers an optional USB printer for use with the 

Gel Doc XR+ and ChemiDoc XRS+ systems: the Mitsubishi thermal printer (catalog 

#1708089). For more information about the Mitsubishi thermal printer, see the Image 

Lab Software User Guide. 

Conversion Screens

White Light Conversion Screen

The white light conversion screen (catalog #1708001) is a phosphor screen that 

produces white light transillumination when placed on top of the UV transilluminator. 

XcitaBlue Conversion Screen

The optional XcitaBlue™ screen (catalog #1708182) is a UV to blue light conversion 

screen, which enables you to visualize DNA samples while protecting them from UV 

damage.
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2 Gel Doc XR+ Imager

Refer to the Gel Doc™ XR+ Installation Guide in the installation kit for information 

about installing and calibrating the imaging system. To recalibrate the imager when 

you acquire new accessories, refer to Chapter 5, System Calibration.

Gel Doc XR+ Imager Workflow

Following are the basic steps for acquiring, analyzing, and archiving an image using 

the Gel Doc XR+ imager and Image Lab™ software:

1. Select a protocol or create a new one.

2. Position the sample you want to image.

3. Run the protocol.

4. View the results.

5. Optimize the analysis.

6. Generate a report.

7. Save or export the results.
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Gel Doc XR+ Technical Specifications 

Applications

Chemiluminescence No

Fluorescence* Yes

Colorimetry Yes

Gel documentation Yes

Hardware Specifications

Maximum sample size  Length: 28 cm

 Width: 36 cm

Maximum image area  Length: 19.4 cm

 Width: 26 cm

Excitation source  Trans-UV and epi-white are standard (302 nm 

included, with 365 nm available as an option).

 Optional trans white, self-powered or conversion 

screen.

 Optional XcitaBlue™ UV/blue conversion screen.

Illumination control 3 modes:

 Trans-UV

 Trans white

 Epi-white

Detector CCD

Pixel size 4.65 x 4.65 (H x V in microns)

Cooling system Not applicable

Camera cooling temperature Not available

Filter holder 3 positions:

 2 for emission filters

 1 for using no filter

Emission filters  1 included (standard)

 3 optional
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Dynamic range >3.0 orders of magnitude

Pixel density (gray levels) 4,096

Dynamic flat fielding Application-specific, for all applications

Instrument size  Length: 36 cm

 Width: 60 cm

 Height: 96 cm

Instrument weight 32 kg

Operating Ranges

Operating voltage 110/115/230 V AC nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity <70% noncondensing

Automation Capabilities

Workflow automated selection Application driven, user selected or recalled by a 

protocol

Workflow automated execution Controlled by a protocol via application-specific 

setup for image area, illumination source, filter, 

analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols; from 

image capture to quantitative analysis and reports

Autofocus Precalibrated focus for any zoom setting 

Image flat fielding Dynamic; precalibrated and optimized per 

application

Autoexposure 2 user-defined modes (intense or faint bands)

* When acquiring images from SYBR® Safe DNA applications, Bio-Rad highly recommends 

that you use the optional XcitaBlue Conversion Screen kit (catalog #1708182), which enables 

you to visualize DNA samples and protects them against UV damage.
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3 ChemiDoc XRS+ Imager

Refer to the ChemiDoc™ XRS+ Installation Guide in the installation kit for 

information about assembling and calibrating the imaging system. To recalibrate the 

imager when you acquire new accessories, refer to Chapter 5, System Calibration.

In addition to the applications that can be used with the Gel Doc XR+, the 

ChemiDoc XRS+ can acquire images from chemiluminescent blots.

ChemiDoc XRS+ Imager Workflow

Following are the basic steps for acquiring, analyzing, and archiving an image using 

the ChemiDoc XRS+ system and Image Lab software:

1. Select a protocol or create a new one.

2. Position the sample to be imaged.

3. Run the protocol.

4. View the displayed results.

5. Optimize the analysis.

6. Generate a report.

7. Save or export the results.

When running chemiluminescent blots, you can use signal accumulation mode 

(SAM), which takes a series of exposures in a set period of time. You can then 

choose the image with the optimal signal. Refer to Chapter 3, Acquiring Images for 

more information.
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ChemiDoc XRS+ Technical Specifications 

Applications

Chemiluminescence Yes

Fluorescence* Yes

Colorimetry Yes

Gel documentation Yes

Hardware Specifications

Maximum sample size  Length: 28 cm

 Width: 36 cm

Maximum image area  Length: 26 cm

 Width: 35 cm

Excitation source  Trans-UV and epi-white are standard (302 nm included, with 

365 nm available as an option)

 Optional trans white, self-powered or conversion screen

 Optional XcitaBlue™ UV/blue conversion screen

Illumination control 5 modes:

 Trans-UV (standard)

 Epi-white (standard)

 No illumination for chemiluminescence (standard)

 Trans white (optional)

 XcitaBlue (optional)

Detector Supercooled CCD

Pixel size 6.45 x 6.45 (H x V in microns)

Cooling system Peltier cooled

Camera cooling 

temperature

–30°C controlled

Filter selector 3 positions:

 2 for filters

 1 without filter (for chemiluminescence)
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Emission filters  1 included (standard)

 3 optional

Dynamic range >4.0 orders of magnitude

Pixel density (gray levels) 65,535

Dynamic flat fielding Application-specific, for all applications

Instrument size  Length: 36 cm

 Width: 60 cm

 Height: 96 cm

Instrument weight 32 kg

Operating Ranges

Operating voltage 110/115/230 V AC nominal

Operating temperature 10–28°C (21°C recommended)

Operating humidity <70% noncondensing

Automation Capabilities

Workflow automated 

selection

Application driven, user selected or recalled by a protocol

Workflow automated 

execution

Controlled by a protocol via application-specific setup for image 

area, illumination source, filter, analysis, and reporting

Workflow reproducibility 100% repeatability via recallable protocols; from image capture 

to quantitative analysis and reports

Autofocus Precalibrated focus for any zoom setting or sample height

Image flat fielding Dynamic; precalibrated and optimized per application

Autoexposure 2 user-defined modes (intense or faint bands)

* When acquiring images from SYBR® Safe DNA applications, Bio-Rad highly recommends that you 

use the optional XcitaBlue Conversion Screen kit (catalog #1708182), which enables you to visualize 

DNA samples and protects them against UV damage.
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4 Acquiring Images

Image Lab software runs configurable application-based, protocols for sample 

imaging. In a single acquisition, a protocol runs a combination of settings for 

acquiring an image, analyzing it, and creating a customized report. 

Protocols can be retrieved, revised, and reused. 

Images you acquire at high resolution result in large files. For this reason, Bio-Rad 

recommends archiving images by exporting the files to network file server or to 

removable storage media.

For more detailed information about protocols, see the Image Lab Software User 

Guide.
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Creating Protocols

Creating a protocol consists of configuring acquisition, analysis, and output 

settings. Analysis and output settings are optional. 

To create a protocol, you configure these settings on the Protocol Setup screens. 

The title bar above the Protocol Setup screen displays the protocol name and 

imager type. Main steps appear as headings in the left pane of each screen. 

Numbered steps appear under these headings.

Analysis settings consist of the following:

 Detecting lanes and bands

 Analyzing molecular weight

Output settings consist of the following:

 Printing the image

 Printing the report

 Displaying the report
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To choose options for a protocol step, select the checkbox to the left of the 

numbered step. To disable a numbered step, clear its checkbox.

Options for the selected step appear on the right side of the screen. 

To determine the optimum imaging time for a chemiluminescent sample, select the 

signal accumulation mode (SAM) option. 

Using Signal Accumulation Mode (SAM)

(ChemiDoc™ XRS+ only) When you run a chemiluminescence application, you can 

choose signal accumulation mode (SAM) under Image Exposure on the Gel Imaging 

protocol setup screen. 

SAM simplifies obtaining an optimal image from a chemiluminescent sample. This 

sample type often requires long integration times to obtain an image that represents 

the best range of signal. SAM acquires a number of images with different imaging 

times so you can compare the images and then select the optimum imaging time.

SAM presents a series of cumulative images with progressively greater signal in 

each image. To run SAM you must estimate the shortest and longest times 

expected to generate an image with the appropriate signal intensity. You then 

decide how many total images to acquire in this period of time.

For example, if the minimum expected time to image the sample is 1 minute and the 

maximum is 5 minutes, you enter these values (in seconds) in the Setup dialog box. 

The value you enter in the Total number of images box defines the number of 

images SAM captures in the defined interval.
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In this example, images are acquired at 1 minute intervals, starting at 1 minute and 

ending at 5 minutes. The second 1-minute image is added to the first 1-minute 

image, and the final image is the result of integrating these two images. The third 1-

minute image is added to the previous image, and so on, until the last image is 

presented.

Although SAM is useful for determining the optimum imaging time for a 

chemiluminescent sample, it results in data that are not as accurate as data from a 

single image. Signal that is near the intensity of background noise becomes 

increasingly masked as the number of cumulative images grows. To identify 

extremely faint signals in an image, reacquire it as a single image, using the time the 

SAM tool found to be appropriate.

Note: For more information about acquiring and saving SAM images, see 

Running a Protocol with SAM in this chapter.

Accessing Protocol Setup Screens

To access the default Protocol Setup screen

1. Verify that the name of your imager appears on the status bar.

The green check mark indicates that the imager and the computer running 

Image Lab software are communicating with each other. 

2. Click New Protocol on the toolbar.

The Protocol Setup screen appears. Gel Imaging is selected in the left pane.
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Gel imaging options appear on the right side of the Protocol Setup screen. The 

protocol name appears in the title bar. You can change this name when you 

save the protocol. 

Choosing an Application

The term application refers to sample type. The sample types consist of the 

following options:

 Nucleic acid gel, protein gel, or blot 

 Detection reagent — dye or stain

In the Gel Imaging Protocol Setup screen, you can choose from a list of predefined 

applications for common sample types. Each sample type is predefined with 

optimal acquisition settings.

To use a dye or stain not listed in the Application dropdown menus, you can choose 

the application type Custom and create a custom application. For more information, 

see Setting Up a Custom Application on page 37.
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Configuring a Protocol

 On the Protocol Setup screen toolbar, click New Protocol.

The Protocol Setup screen appears with Gel Imaging selected. Acquisition 

options appear in the right pane.

To configure acquisition settings

1. Under Application, click Select an application type. 

2. In the dropdown menu that appears, choose a predefined application.

 

Note: When you select Stain Free Gel, you can also select the gel 

activation time. See Appendix D, Using Bio-Rad Stain-Free Technology, for 

more information.

 Under Imaging Area, select the appropriate gel type or enter image area 

dimensions. The red box to the right represents the imaging area for the 

selected gel. The gray rectangle represents the imager sample stage.

Under Image Exposure, select one of the following:
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 Auto Exposure — estimates an optimal exposure time and ensures the 

best use of the dynamic range.

 Intense Bands — optimizes exposure for all bands.

 Faint Bands — uses a longer exposure time, making faint bands more 

visible; more prominent bands might be overexposed.

After imaging a gel optimized for automatic exposure, the exposure time 

used appears on screen. You can use it as a reference to set a manual 

exposure time.

 Manual Exposure — overrides the automatic option. Exposure time can 

range from 0.001–99 seconds (Gel Doc™ XR) and from 0.001–7,200 

seconds (ChemiDoc XRS+). You can view the image exposure time in the 

Image Info dialog box, which you can access in the Display Toolbox above 

the on-screen image.

3. (ChemiDoc XRS+ only) Signal Accumulation Mode — when you run a 

chemiluminescence application, you can also select SAM. To do so, select it 

under Image Exposure.

4. Display Options — two settings enable you to fine-tune image appearance:
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 Highlight saturated pixels — display saturated pixels in red, which 

indicates how much of the gel image is saturated. You can change this 

option later: select View > Image Transform

5. Save the protocol and run it or go to the analysis and output settings.

Configuring Analysis Settings

To analyze a gel or blot automatically, configure analysis settings in the following 

protocol setup tasks:

 Detect Lanes and Bands

 Analyze Molecular Weight

For information about these settings, see the chapter, Protocols, in the Image Lab 

Software User Guide.

Configuring Output Settings

When you display a report, a scrollable report screen appears in which you can view 

the image, acquisition settings, and analysis data. You can view or print a single 

image or report.

Note: You cannot print a report on a thermal printer.

To specify protocol output

1. Select Specify Output in the left pane of the Protocol Setup screen.

 Output options appear in the right pane.
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2. Choose one of the following:

 Automatically print the image

 Automatically print a report

 Display the report

Image Lab prints to the default printer unless you select another printer. 

See the chapter, Generating Reports, in the Image Lab Software User Guide for 

information about customizing reports.

Positioning the Gel

After configuring protocol setup steps, position the gel on the imaging stage and 

adjust the camera zoom level in Image Lab.

With the Bio-Rad gel alignment template kit you can center four sizes of standard 

agarose gels and ensure the consistent placement of each gel. See Appendix C, 

Accessories for more information.

Tip:  To review protocol settings, click Protocol Summary in the left pane. 
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To position a gel

1. Place a gel on the imaging stage and center it. 

2. In Image Lab, click Position Gel in the Protocol Setup screen.

3. The Run screen appears.

4. Adjust the camera zoom level with the slider below the image.

5. Click Run Protocol. 

After the protocol runs, the acquired image appears.
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For more information about running a protocol, see the chapter, Protocols, in the 

Image Lab Software User Guide.

Running a Protocol with SAM

Note: Only the ChemiDoc XRS+ imaging system works with Signal 

Accumulation Mode (SAM). SAM can be used only with chemi applications. 

You can interrupt the acquisition of images for a SAM-enabled protocol at any time. 

To do so, click Stop Acquire and Continue with Selected. The acquisition process 

stops and then continues the protocol with the image you select. Images already 

acquired are discarded.
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To view a SAM image in the workspace

 Click its thumbnail.

To save the image you want to analyze

1. Review the images and identify the image you want to use in your analysis.

Important: Save the image you want to keep before you continue running 

the protocol. When you click Select Image and Continue, the selected 

image is saved and all unsaved images are deleted. 

2. Select the image you want and click Select Image and Continue. 

Image Lab continues to the next step in the protocol using the image you 

selected.

Saving SAM Images

To save a SAM image

1. Right-click its thumbnail and click Save.

2. In the Save File dialog box, accept the default file name or enter another name. 

Click Save.
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To save all SAM images

1. Right-click a SAM image and select Save All.

2. In the Select Directory dialog box, enter a folder name and click Choose.

The images are saved in the specified folder. The name of the file includes the 

user name, timestamp, and exposure time. For example: 

John Doe 2015-05-01 15 hr 44 min_Exposure_5.0sec.

Setting Up a Custom Application

When you create a protocol, Image Lab displays a list of application types and 

predefined applications for acquiring images. To use a dye or stain not listed in the 

Application dropdown menus, you can choose the application type Custom and 

create a custom application. Also choose Custom to do the following:

 Choose a previously saved custom application

 Edit or rename a custom application

Note: If you are not sure how to configure a custom application for a dye or 

stain, contact Bio-Rad Technical Support.

To create a custom application

1. On the Protocol Setup screen, select 1. Gel Imaging. 

2. Under Application, click Select and choose Custom on the menu that appears.

The Manage Custom Applications dialog box appears. 
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3. Click New.

The Create Custom Application dialog box appears.

4. Enter a unique application name.

5. Under Application Settings, select a light source, filter, and image color. 

Viewing the image with a different color scheme can make all of its elements 

more visible. 

6. (ChemiDoc XRS+ only) Select a binning setting.

A higher binning setting combines pixels to increase the amount of signal 

without increasing noise. A higher setting provides optimal sensitivity for low-

light applications such as chemiluminescence, but it reduces image resolution.
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Editing a Protocol

You can open a protocol, change its settings, and save it with another name. You 

can also disable a step in the saved protocol. When you edit a default protocol and 

save it with a new name, the default protocol is unaffected. 

See the chapter, Protocols, in the Image Lab Software User Guide for more 

information.
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5 System Calibration

When the imager is installed, it is calibrated using a calibration wizard. For detailed 

instructions, see the installation guide in the imager installation kit. 

The Image Lab™ software instrument calibration wizard provides several options 

required to automate the system and prevent focus problems. Each of these 

calibrations affects the system as follows:

 Focus Calibration — allows automated focus settings at any zoom point, 

using a software algorithm. This ensures that the focus remains correct 

whether you view an entire sample or an area of interest.

 Focus Calibration with Height Offset —takes the tallest of the available 

conversion screens into account and extrapolates values for the others so 

that focus remains optimal for the screen in use. Checking the Illumination 

options on the Instrument Setup screen instructs Image Lab to generate 

the focus calibration offset. Focus calibration offset does not change flat 

field calibrations.

 Dark Reference Image — determines and corrects any background signal 

present in the imager. (Gel Doc™ XR+ imaging system only)

 UV Flat Field Calibration —generates the flat field correction profiles required 

for the UV light source. The orange flat field generates a flat field profile for UV. 

Because of this calibration, the images have more accurate quantity reporting 

and backgrounds of even intensity.

 Lens Flat Field Calibration — corrects for the intensity roll-off inherent in 

any lens.
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 White Conversion Screen Calibration —generates a flat field correction 

profile required for the white light conversion screen. 

 Bias Value Correction — corrects bias for a no-light baseline camera 

readout. (ChemiDoc™ XRS+ system only)

Recalibrating the Imager

When you add light sources or filters to the Gel Doc XR+ or ChemiDoc XRS+ 

imager, you must recalibrate the imager. 

To recalibrate the imager

1. In Image Lab, click Edit > Instrument Setup.

2. The Instrument Setup dialog box appears.

 

3. (Optional) To add a new light conversion screen, select the appropriate box in 

the Illumination Options field. 
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For more information, see Appendix C, Accessories.

4. For any other changes to the optical pathway, perform a flat field calibration. To 

do so, click Reset in the Instrument Calibration > Flat Field group and follow the 

on-screen instructions.

Note: When you use the imager to conduct quantitation with Bio-Rad 

stain-free gel technology, Bio-Rad recommends performing the flat field 

calibration with the orange fluorescence reference plate (catalog # 

1708008) after installing Image Lab 6.0. For instructions, see Orange 

Fluorescence Reference Plate on page 58.

5. Wait for the software to prompt you to recalibrate the new illumination sources.

6. Click OK.
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A Maintenance

UV Transilluminator Lamp and Starter Replacement

Important: Keep the UV filter surface clean from the chemical agents used as 

gel dyes. Use protective gloves when touching the UV transilluminator cover. 

Depending on usage, the UV bulbs and starters can last for many years. Replace 

bulbs when you notice them flickering. If a bulb does not turn on when it is new or 

moved, replace the bulb starter and test the bulb again.

Two types of bulbs are available. The catalog numbers are listed in Appendix C, 

Accessories. The standard bulb is 302 nm. Optionally, the 365 nm bulb is used to 

minimize denaturing of DNA.

To replace the lamps

1. Turn off the power.

2. Disconnect the power cord from the universal hood.

3. Remove the four screws located on the left/right sides of the transilluminator 

cover.

4. To remove the cover with the UV glass, slide it forward and then lift it up.

Note: Do not put the UV cover directly on the bench. Wear gloves when 

touching the lamps.

5. Place the cover on a nonabrasive surface so that the glass does not get 

scratched or damaged.
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6. Rotate the lamp until it becomes loose and the pins come to a vertical position.

7. Remove the lamp. 

8. Install the new lamp by rotating it so that the pins are horizontal and the lamp is 

tight.

9. Remove the starter by rotating it counterclockwise and then pulling it out.

10. Insert the new starter into the holder and rotate it clockwise.

11. .Reassemble the cover and retighten the screws on both sides.
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Epi-Illumination Lamp Replacement

The lamps are located behind two cover panels on the left and right sides of the 

universal hood’s interior.

To replace the lamps

1. Turn system power off and remove the power cord.

2. Open the enclosure door.

3. Locate the epi-white light housing inside the hood and the screw on the center 

of the housing cover.

4. Use a socket wrench to remove the screw.

5. Pull the cover to remove it from the housing. 

The lamp is now visible.

6. To remove the lamp, hold it at the plastic receptacle and pull it from the 

receptacle.

7. Insert the new lamp into the lamp receptacle and push until it is firmly seated in 

the receptacle.

8. Reassemble the epi-white light cover.
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Fuse Replacement

Caution: Always unplug the instrument before changing or checking the fuses.

This unit is protected by two fuses (5 x 20 mm, 2A Slo-Blo). The fuses are located in 

the left side rear of the universal hood, in a fuse holder housed in the power entry 

module.

To replace the fuses

1. Unplug the main power cable from the power outlet.

2. Use a screwdriver as a lever on the fuse holder to extract the fuse.

3. Remove the blown fuses and replace them with two new fuses 

(catalog #9008935).

4. Slide the fuse holder into the power entry module until it snaps into place.

Power outlet Fuse holder
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B Troubleshooting

The following table lists potential problems and suggested solutions.

Problem Possible Cause Solution

Camera does not 

respond/camera not 

found

 Power to the camera 

may be turned off.

 The camera cables 

might not be seated 

properly.

 The software driver for 

the camera is missing.

 Computer power-saving 

modes might be 

interfering with the 

camera driver.

 The cables might be 

defective.

 The camera might be 

defective.

 Turn on the power to the camera.

 Make sure that all cables are 

connected as shown in the 

Installation Guide.

 If the camera driver is not present, 

reload the camera driver from the 

Image Lab™ software CD.

 Disable the power-saving modes on 

the computer.

 Replace the cables.

 Replace the camera.

Horizontal stripes in 

image when using 

the UV mode

 The emission filter might 

not be positioned 

properly.

 Cycle power to the Universal Hood III 

so that the filter wheel is positioned 

properly.

Image is not visible 

on the monitor

 The monitor settings are 

incorrect.

 The lens cap is 

attached.

 See your computer manual for the 

proper settings.

 Remove the lens cap.
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Printout does not 

look like the monitor 

image

 The monitor settings are 

wrong.

 The printer settings are 

wrong.

 See your monitor manual for the 

appropriate settings.

 See your printer manual for the 

appropriate settings.

Light leakage into the 

darkroom

 The lens body is not 

seated properly against 

the gasket on the hood’s 

adapter plate.

 Loosen the thumbscrew and seat the 

lens properly against the gasket on 

the hood’s adapter plate.

Unable to focus on 

the sample using 

white light 

conversion screen

 Focus is not calibrated 

for samples using this 

light source.

 Select Edit > Instrument Setup to 

recalibrate the focus for use with this 

accessory.

Lens limits seem 

artificially restricted

 The camera lens is not 

seated properly on the 

lens mounting plate.

 Re-seat the camera on the lens 

mounting plate.

Problem Possible Cause Solution
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C Accessories

Calibrating Accessories

When you install accessories during initial installation of the imaging system, you 

must run the one-time Instrument Calibration wizard to calibrate the system. Refer 

to the installation guide for instructions.

You must also recalibrate the imager before using new conversion screens, light 

sources, or filters. See Chapter 5, System Calibration for more information about 

calibrating new accessories.
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Installing Optional Accessories

UV/White Light Conversion Screen

This optional white light conversion screen (catalog #1708289) converts the UV light 

generated in the universal hood to white light. The imager must be calibrated to use 

the white light conversion screen.

The UV/White Light conversion screen is held in place by adhesive-backed edge 

guides. After the edge guides are installed, the conversion screen remains centered 

and does not slide, even when you close the drawer rapidly.
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To install the UV/White Light conversion screen

Important: Do not remove the adhesive paper tape from the edge guides until 

step 2. You cannot reposition the adhesive surfaces of the edge guides once 

they are set in place.

1. Holding the screen right side up with the paper taped edge guides underneath, 

practice positioning the edge guides so that they touch the inside of the 

transilluminator drawer front and fit over the edge of the metal transilluminator 

border (shown in red).

2. When you have positioned the edge guides to your liking, remove the paper 

tape from under each guide.

3. Carefully press each edge guide into position. 

4. To visualize a sample using the screen, place the screen between the edge 

guides.

5. Use the gel alignment template kit to center the gels on top of the screen 

consistently. For more information, see To use a gel alignment template with a 

conversion screen on page 58.

Adhesive-backed
edge guide

Transilluminator
drawer front

Transilluminator
border edge
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To calibrate the imager

1. In Image Lab™ software, choose Edit > Instrument Setup. 

2. Select the White Light Conversion Screen checkbox under Illumination 

Options.

3. Under Instrument Calibration, click Reset for Focus Calibration.

When calibration finishes, the imager is ready to acquire images.

To image a gel with the white light conversion screen

1. Center the conversion screen on the imager stage.

2. Center the samples on top of the conversion screen.

3. Image the gel.

For more information, see Chapter 3, Acquiring Images.
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XcitaBlue Conversion Screen

The optional XcitaBlue™ conversion screen kit (catalog #1708182) converts UV to 

blue light, so you can visualize DNA samples while protecting them against UV 

damage.

The XcitaBlue conversion screen is held in place by adhesive-backed edge guides. 

After the edge guides are installed, the conversion screen remains centered and 

does not slide even when you close the drawer rapidly.

Note: After you install the conversion screen, you must calibrate the imager.

To install the XcitaBlue conversion screen

Important: Do not remove the adhesive paper tape from the edge guides until 

step 2. You cannot reposition the adhesive surfaces of the edge guides once 

they are set in place.

1. Holding the screen right side up with the paper taped edge guides underneath, 

practice positioning the edge guides so that they touch the inside of the 
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transilluminator drawer front and fit over the edge of the metal transilluminator 

border (shown in red).

2. Position the edge guides to your liking. 

3. Remove the paper tape from under each guide.

4. Carefully press each edge guide into position. 

5. To visualize a sample using the screen, place the screen between the edge 

guides.

6. Use the gel alignment template kit to center the gels on top of the screen 

consistently. 

To calibrate the imager

1. In Image Lab software, choose Edit > Instrument Setup. 

2. Under Illumination Options, select the XcitaBlue Conversion Screen checkbox.

3. Under Instrument Calibration, click Reset for Focus Calibration.

Adhesive-backed
edge guide

Transilluminator
drawer front

Transilluminator
border edge
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When calibration finishes, the instrument is ready to acquire images.

To image a gel on the blue light conversion screen

1. Center the conversion screen on the imaging stage.

2. Center the samples on top of the conversion screen.

3. Select a protocol and image the gel.

For more information, see Chapter 3, Acquiring Images.

Gel Alignment Template Kit

The Bio-Rad gel alignment template kit (catalog #1708184) enables you to center 

four sizes of standard agarose gels quickly and ensures the consistent placement of 

each gel. 

Note: Using the gel alignment template kit does not affect imager calibration.

The kit contains

 Magnetic locator frame

 Instruction sheet

 Alignment guides for the following gel trays:

7 x 7 cm 15 x 7 cm 7 x 10 cm

Magnetic
locator
frame

15 x 10 cm
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 Sub-Cell® GT UV-transparent mini-gel tray, 7 x 7 cm

 Sub-Cell GT UV-transparent wide mini-gel tray, 15 x 7 cm

 Sub-Cell GT UV-transparent mini-gel tray, 7 x 10 cm 

 Sub-Cell GT UV-transparent gel tray, 15 x 10 cm

The gel alignment templates fit exactly into the XcitaBlue conversion screen frame 

(catalog #1708182).

To use a gel alignment template with a conversion screen

1. Remove the magnetic locator frame if it is on the transilluminator.

2. Place the conversion screen on the transilluminator.

3. Place the gel alignment template that matches the size of the sample tray or 

agarose gel inside the conversion screen frame.

4. Place the gel or gel tray into the open area of the template.

To use a gel alignment template with the magnetic locator frame

1. Place the magnetic locator frame over the transilluminator with the magnetic 

side down. 

2. Match the corners of the magnetic locator frame with the edges of the 

transilluminator. 

3. Position the magnetic locator frame so that its UV symbol matches the 

direction of the UV symbol on the imager. 

For example:

4. Place the gel alignment template that matches the size of the sample tray or 

agarose gel into the magnetic locator frame.

5. Place the gel or gel tray into the open area of the template.
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Orange Fluorescence Reference Plate

The orange fluorescence reference plate enables you to apply UV flat fielding 

corrections to the imager. Corrections are made for all UV illumination sources, 

filters, and the camera lens. 

The orange fluorescence reference plate is recommended for quantitation with 

Bio-Rad’s stain-free gels and can correct for image nonuniformities for other 

fluorescent applications, including the following:

 Ethidium bromide

 GelRed

 Flamingo™ 

 Coomassie Fluor Orange

 SYPRO Ruby 

 Krypton

 Qdot 625

The orange fluorescence reference plate (catalog #1708008) can be used with 

several of the Bio-Rad® Molecular Imager® series of products, including

 Gel Doc™ XR+ imaging system with Image Lab™ software

 ChemiDoc™ XRS+ imaging system with Image Lab software

Orange fluorescence reference plate, overall dimensions: 29.5 x 29.5 cm; viewing 

surface: 27 x 27 cm, ships with Instruction sheet (10017296).
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Calibrating the Imager for the Orange Fluorescence
Reference Plate 

You must recalibrate the imager before using the orange fluorescence reference 

plate.

To recalibrate the imager

1. Choose Edit > Instrument Setup.

2. In the Edit menu, click Instrument Setup.

The Instrument Setup dialog box appears

3. Under Flat Field, click Reset and then click OK. Follow the instructions that 

appear on screen. 
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Ordering Information

The following table lists catalog numbers and descriptions for all parts available for 

the Gel Doc XR+ and ChemiDoc XRS+ systems, plus all optional accessories and 

replacement parts. For additional information, see the Bio-Rad catalog.

Table 3. Ordering information 

Catalog # Description

Molecular Imager System (includes universal hood, camera, cables, and 
accessories)

1708195 Gel Doc XR+ with Image Lab software system for PC/Mac

1708265 ChemiDoc XRS+ with Image Lab software system for PC/Mac 

Installation Kits

1708199 Image Lab™ Upgrade for Gel Doc XR+ System

1708299 Image Lab Upgrade for ChemiDoc XRS+System

Image Lab Software

1709690 Image Lab software, Windows/Mac

Optional Filters

1708074 Filter, 520DF30, GFP

1708075 Filter, 560DF50, Cy3/rhodamine 

1708076 Filter, 630BP30, SYPRO Ruby 

Optional Accessories

1708289 UV/White light conversion screen (UV to white light)

1708182 XcitaBlue (UV to blue light) conversion screen kit, without standard 

detection filter

1708008 Orange fluorescence reference plate 

1703759 Bio-Rad fluorescent ruler

1703760 Gel cutter ruler

1708184 Gel alignment template kit 
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Replacement Parts

1708026 Focus calibration target

1708027 Image Lab flat fielding disc

1708185 XcitaBlue viewing goggles

1002784 UV transilluminator lid (includes UV filter glass)

10014106 Thumbscrew for camera

1708081 Standard emission filter replacement, 62 mm

1001370 UV bulb starter, quantity 3

Lamps

1002827 Lamp, epi-illumination, 5 W

1708097 302 nm lamp kit, (6 lamps)

1706887 365 nm lamp kit, (6 lamps)

Fuses

9008935 Fuse T 2 A, 250 V, quantity 10

1900234 Fuse T 4 A, 250 V, quantity 2

Optional Analysis Software

1709600 Quantity One software

1708205 2.5 kb molecular ruler

1708200 AmpliSize® molecular ruler

1708356 EZ Load precision molecular mass ruler (base pairs/ng of sample)

Table 3. Ordering information, continued

Catalog # Description
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D Using Bio-Rad Stain-Free 
Technology
Bio-Rad stain-free gels eliminate the time-consuming staining and destaining steps 

required by other protein detection methods. Stain-free gels include unique trihalo 

compounds that allow rapid fluorescent detection of proteins with the Gel Doc™ 

XR+ and ChemiDoc™ XRS+ imagerswithout staining.

When using Image Lab™ software, the Gel Doc XR+ and ChemiDoc XRS+ imagers 

are stain-free enabled to image the following gels:

 Criterion™ TGX Stain-Free™ precast gels

 Criterion Stain Free™ precast gels

 Mini-PROTEAN® TGX Stain-Free™ precast gels

 TGX Stain-Free™ FastCast™ acrylamide solutions for handcast gels

When trihalo compounds in the gels encounter tryptophan residues, a UV 

light-induced reaction produces fluorescence, which can be easily detected by the 

imager in gels or on low fluorescence polyvinyl difluoride (PVDF) membranes. 

Activation of the trihalo compounds in the gels adds 58 Da moieties to available 

tryptophan residues and is required for protein visualization. Proteins that do not 

contain tryptophan residues cannot be detected using this technology. The 

sensitivity of stain-free gels is comparable to staining with Coomassie Brilliant Blue 

for proteins with a tryptophan content >1.5%; sensitivity superior to Coomassie 

staining is possible for proteins with a tryptophan content >3%.

The benefits of stain-free technology include

 Elimination of staining and destaining steps for faster time to results



D  |  Using Bio-Rad Stain-Free Technology

64  |  Gel Doc XR+ and ChemiDoc XRS+ Imaging Systems with Image Lab Software

 No background variability within a gel or between gels (as is often seen 

with standard Coomassie staining)

 Elimination of the need for acetic acid and methanol in staining and 

destaining, which reduces organic waste

 Visualization of transferred or blotted proteins on low fluorescence PVDF 

membranes 

Stain-Free Workflow

For detailed information about the Activate/image gels step, refer to Chapter 3, 

Acquiring Images. For all other workflow steps, refer to the Criterion™ Precast Gels 

Instruction Manual and Application Guide (bulletin #4110001) or to the 
Mini-PROTEAN® Precast Gels Instruction Manual and Application Guide 

(bulletin #1658100).

Prepare buffers

Prepare gels and assemble
electrophoresis cell

Prepare and load samples

Perform electrophoresis

Activate/image gels

Analyze the separation
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Electrophoresis with Stain-Free Gels

Stain-free gels are made and packaged without sodium dodecyl sulfate (SDS), 

allowing them to be used for both SDS and native polyacrylamide gel 

electrophoresis (PAGE) applications.

To perform electrophoresis with stain-free gels

1. Prepare the sample and running buffers.

2. Set up the electrophoresis cell.

3. Perform the run.

Imaging Gels

Use unstained standards with stain-free gels, as some prestained standards are not 

compatible with stain-free technology. To monitor electrophoresis, use a 1:1 mixture 

of unstained and prestained standards.

Setting up a protocol for stain-free gels is similar to setting up protocols for other 

applications. Follow the instructions in Creating a Protocol on page 20. Choose one 

of the following activation times based on the sample and the purpose of your 

experiment:

 Gels used in blotting — use 1 min activation for optimal results when 

performing western blotting followed by immunodetection.

 Good sensitivity — use 2.5 min activation when samples are abundant 

and when a fully optimized signal-to-noise ratio is not necessary.

 Best sensitivity — use 5.0 min activation for detection of proteins that are 

in low concentration and for the best quantitation of the maximum number 

of bands. Because the reaction is near completion after 5 min, this method 

offers an optimal signal-to-noise ratio.

Note: If the gel has been activated for 2.5 min, activating it for another 2.5 min 

might improve it. But activating an image for more than 5 min will not.



D  |  Using Bio-Rad Stain-Free Technology

66  |  Gel Doc XR+ and ChemiDoc XRS+ Imaging Systems with Image Lab Software

Imaging Blots

To blot stain-free gels, use standard blotting procedures as described in the 

instruction manual you are using. Use only PVDF membranes with low background 

fluorescence, as membranes other than low fluorescence PVDF can result in high 

background or low sensitivity with the imager.

To assess transfer efficiency, be sure to activate and visualize the gel using the 

imager before transfer.
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Glossary 

 

Aspect ratio The ratio of the width to the height of an image.

CCD (Charge-coupled device) A light-sensitive silicon chip used as a 

photodetector in Gel Doc™ XR+ and ChemiDoc™ XRS+  camera 

systems.

Colormaps Different color representations of a gel image.

Electrophoresis A technique for separating molecules based on the differential 

movement of charged particles through a matrix when subjected to an 

electric field.

Example precision The number of decimal places chosen for displaying a measurement.

Flat fielding An average intensity computation that compensates for 

nonuniformities generated by an instrument.

Histogram A graphed representation of the brightness, or gray value, of an image.

Imager The instrument without Image Lab software.

Imaging system The instrument connected to a computer running Image Lab™ 

software.

Native charge 
density

The inherent electrical charge of a protein without the addition of SDS.

pl Isoelectric point; the pH at which a protein molecule carries no net 

charge.

Quantitative 
imaging

Determines the quantity of a protein’s components through analysis of 

the pixel values in a digital image of the sample.

UV-B The range of ultraviolet light used by the system.

UV transilluminator The part of the imager that transmits UV light through a sample.
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